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INTRODUCTION 

 

Congratulations for choosing MIS2000 as your migrant education data management tool.  This 
MIS2000 system has been configured specifically to the needs of your migrant program. 

 

MIS2000 allows you to store data from Certificates of Eligibility (COEs), education records, 
health information, as well as any additional information your program collects.  MIS2000’s 
powerful reporting tools allow you to run unlimited preinstalled reports, create your own reports 
on the fly, print copies of COEs, run eligible student counts, as well as federal performance 
reports.  Its unsurpassed data collection and reporting capabilities make MIS2000 the most 
powerful software available to migrant educators. 

 

Management Services for Education Data (MS/EdD), the company that makes MIS2000, was 
founded in 1995. We are located in Little Rock, Arkansas.  See page 104 to find out how you can 
contact MS/EdD. 

 

Don’t forget about the MIS2000 Online Manual, available under MIS2000’s Help menu. 
The Online Manual provides answers right at your fingertips! 
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NOTES 
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MIS2000: A GUIDED TOUR 
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Start Up, Shut Down, and Verify and Backup 
 

Starting MIS2000 

1. Turn on your computer.  
 

2. Double-click on the MIS2000 icon on your Desktop, or go to MIS2000 in your Start Menu. 
The last screen you worked on in MIS2000 will appear. 

 

3. Make sure CAPS are locked (all data must be entered in capital letters). 
 

Shutting down MIS2000 

To close MIS2000, click on the X in the top right corner of the screen. 
 

  
The proper way to turn off your computer is to go to the Start Menu and 
select Shut Down. Pressing your computer’s power button without going to 
the Shut Down menu item can create problems. 

 

Verify and Backup 

The Verify and Backup procedure differs from site to site. Check with your technical liaison or 
MIS2000 technical support to determine how your Verify and Backup is being done. In some 
states, when you close MIS200 you will be given the option to Verify and Backup your 
database. It is recommended that you run this procedure at the end of each working day. 
 

• Choosing yes will scan the database for corruption, repair any corruption, and create a 
copy of your MIS2000 directory. This copy (a zip file) will be placed at the root of your 
hard drive. 

• Choosing no will close MIS2000 without doing the verify and backup.  

• Choosing cancel allows you to remain in MIS2000. 
 

If you are not given this option when you close MIS2000, then your Verify and Backup is 
probably being done at night.  In this case it is important to leave your computer on when you go 
home for the day. 

 

  
NOTE: Running a Verify and Backup does not guarantee that your 
database is safe. For instance, if your hard drive crashes, both the zipped 
copy and the original database may be lost. Check with your office’s 
computer technician/liaison to find out other ways to protect your 
database from loss or corruption. 
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The Basics 

 

Views of Your Database 

The first thing to learn about MIS2000 is that there are two views onto your database: the Student 
View and the COE view.  

• In COE View you enter the data from your COEs. 
 

• In Student View you enter data Student Data as School History, Health, Tests, and 
Supplemental Programs data. 

 

Student View 

  
The top panel, Personal Data, gives you basic information about the student: Ron Pennel. 
 

The middle panel gives you detailed information about Ron Pennel. The information you see here 
is his School History information. 
 

The bottom panel has buttons that allow you to change the middle section. Notice that the School 
History button is italicized, because that is the currently selected button. If you pressed the Tests 
button, Ron’s test data would appear in the middle panel. 
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COE View 

  
 

The top panel, COE Data, gives you basic information about the COE. 
 

The middle panel gives you detailed information about the COE. Here you see the COE’s 
Children data. 
 

The bottom panel has buttons that allow you to change the detail section. Notice that the Children 
button is italicized, because that is the currently selected button. If you pressed the Family button, 
the middle panel would display the COEs Family information.  
 

See page 15 to learn how to enter COEs. 

 

Navigators 

Navigator bars are mouse-activated. You can use them to move through your database. They 
enable you to add, update, or delete records.  
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Navigator Bar 
 

Notice that when your let your mouse hover over a navigator button, the function of the button is 
listed in the bottom left corner of your screen. 

  
 

When your mouse hovers over the right arrow button on the Navigator Bar, the message "Moves 
to the next enrollment for the current student" appears in the bottom left corner of your screen. 
 

Hotkeys 

If a button has a character that is underlined, you can hold down on your Alt key and the 
underlined letter to press the button. These underlined letters are called hotkeys. 

  
You can hold down the Alt key and the letter "T" to press the Tests button, or Alt and the letter 
"H" to press the School History button. 
 

Shortcuts 

To the right of some pull-down menu items are shortcuts. You can select the menu item by 
holding down the control key and the letter indicated on the shortcut. 

  
To queue a record you can hold down your Control key and the letter "Q." 
 

Control-Tab will toggle you between Student View and COE View. 

Shift-Tab will backspace you to the previous field, so that you don’t have to reach for your 
mouse during data-entry. 



06�(G'�
Management Services for Education Data 

�
 

10 MIS2000 User’s Guide 
 

Pull Down Menus 

Procedures Menu  

Mass Enroll allows you to enroll students on a by-facility basis. 

 

Mass Withdraw allows you to withdraw students on a by-facility basis.  

 

Edit Codes allows you to edit the contents of your drop-down fields (such as district, facility, etc) 

 

Configure Reports allows you to install your own reports in Snap Reports.  

 

Upload Changes sends your latest data to the state server. 

 

Check for Upgrades allows you to connect to the state computer to see if there are any upgrades 
to your MIS2000 system, such as new version of MIS2000, an updated Online Manual, or a new 
report. 

 

Merge Duplicates merges duplicate students.  

 

 
Reports Menu  

Snap Reports  The Snap Reports window allows you to choose a report from your Snap Reports 
list, select appropriate filters if necessary, and run the report. 

 

Report Builder  Report Builder is your tool for creating your own reports. 

 

Potential Duplicate Students This procedure allows you to check your database for students 
who may have two or more records in the system. 

 

Queue Record Pressing the Queue Record button puts the current student’s record into the print 
queue.  

 

Print Queued Records creates a screen preview of all records in the queue. You can then choose 
to print the records, save them, or clear them from the record queue. 

 

Clear Record Queue removes all records from the print queue.  
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Include Health Record is a checkable item controlling whether or not the health information 
prints on the record. To add or remove the check mark, simply click on it. 

 

Include Ed Record is a checkable item controlling whether or not education information, such as 
School History, Tests, etc. prints on the record. To add or remove the check mark, simply click on 
it. 

 

          
Preferences Menu 

Form caching is a checkable item. When checked, it helps MIS2000 to work more quickly. It is 
recommended that you leave it checked. 

 

Auto Caps Lock  is also a checkable item. When checked, it will turn your Caps Lock on for you 
automatically. 

 

Use Windows Short Date Format is a checkable item that controls whether MIS2000 will use 
your default Windows setting for displaying the year. If you want to see only a two-digit year 
(which is best for reporting), leave this item unchecked. 

 

          
COE menu 

This menu only appears in COE View.   
 

Queue COE places the COE you are currently viewing into the printing queue. 

 

Print COE Queue creates a screen preview of all records in the COE queue. You can then 
choose to print the records, save them, or clear them from the record queue. 

 

Clear COE Queue removes all COEs from the printing queue. 

 

Queue all New COEs is a checkable menu item. If you check it, it will add each new COE that 
you enter to the printing queue.  

 

Queue all Students is a checkable menu item. If you leave it checked, it will add all new students 
to the student record queue. 
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Go Menu 

The Go menu provides you with a quick way to get to other information related to the student or 
COE you’re currently viewing. 

 

  
 

Example: Say you are working on the Student Data of Janet Smith. You want to see her COE. Go 
to the Go pull-down menu, and select To COEs. MIS2000 will then show you Janet’s COE(s). 

 

  
NOTE: If the "To COEs" menu item is grayed out (you aren’t allowed to 
select it), then that child does not have a COE in your database.  

 

  

          
View Menu  

The View menu allows you to flip between the COE and Student views.  

 

COE View contains Family and Children screens, which include all of the data collected on your 
state’s COE form.   

Student View contains screens for school history, supplemental programs, credit accrual, and 
any other information that your state’s Migrant Education Program collects on its participants.  

 

  
 

  
NOTE: Changing the view does not take you to the COE/Student Data of 
the student you are currently working on. If you wish to see the 
COE/Student Data of your currently selected student, choose the Go pull-
down menu. 
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WORKING WITH COES 
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Entering COEs 

 

Important 

Note: 

If you are at a regional site that uploads to a state site, it is important that 
you search your state database for the students on your new COEs before 
you enter the COEs. If a student is already entered into the state MIS2000 
database, you need to download that student to your database. You will 
then add that existing Student Data to the new COE. 

Otherwise, you may end up with duplicate students. 

Doing a Batch Search will allow you to search for and download from the 
state site all the students on your COEs before entering the COEs. See 
page 40 to find out how to do a Batch Search. 

 

1. While in COE view, press the "+" on the Navigator Bar to add a new COE to the database. 
You will be given a blank COE, which you will fill in with the information from your state’s 
paper COE form (remember to type in all caps). 
 

2. Enter the data from your paper COE in the white fields. Use the tab key to move from field 
to field. Using the "Tab and Type" data-entry method is much quicker than picking up your 
mouse and clicking each time you need to go to the next field. 

 

3. When you have entered all of your family data, then you are ready to enter the children’s data. 
Tab to the Children button at the bottom of the screen and press Enter. 

 

4. You will add children to the COE one at a time. For each new child, press the New 
Enrollment button. This will automatically bring up the Student Search panel. (Searching 
for students before adding them to a COE decreases the possibility of ending up with 
duplicate students). 

 

5. Enter the student ID if you have it, or you can enter any other information you have about the 
student. 

 

  
NOTE: It is sometimes best to enter less information rather than more. 
The more data you enter, the more likely you are to make a typo. Also, 
the data you enter must match exactly the data in the database. If the 
original data-entry person made a typo, your match wouldn’t be found.  

 

6. When you have filled in the data, press the Do Search for Child button to find the child in 
your local database. 
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7. When your search is completed the results will display in the grid: 

 

• If the student you are looking for is listed: Select the student and press the Select 
Child button. This child will be added to the COE and will get a new School History 
line with the same enroll date, QAD date, etc that are listed on the COE. 

 

• If the child you are looking for does not appear in the grid, press the New Child 
button. 

 

8. Fill in the blank fields. Use the tab key to move from field to field. If you have selected a 
child that was already in the database, you will still have some fields to fill in. 

 

9. Once you have entered the data, press the Update Record button (a few states don’t have this 
button). The child’s enrollment data will be added to the School History grid. 

 

10. If you have another child to enter, press the New Enrollment button again and follow steps 
5-9 to add the child to the COE. 

 

11. Once you have entered the last child on the COE, press the + on the top Navigator bar to start 
a new COE. Or, if you are finished, you can close MIS2000. Your new COE will be saved 
automatically. 

 

  
NOTE: When you add a new student to a COE, that student’s  
information such as name, birthdate, and enrollment data, is copied over 
into Student View as "Student Data." 

To look at that Student Data in Student View, highlight the child in the 
COE children grid. Open the Go menu, and select To Student. You will 
then see the Student Data that was copied when you added the new child 
to the COE.  

When you add a previously existing child to a COE, the new enrollment 
data you gave the child will also be added to the child’s Student Data 
panel. 
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Searching for COEs  

 

1. In COE view, click the Search button in the top left corner of the screen. 

 

2. The Find COE window will appear. Enter your data. 

 

  
NOTE: It is sometimes best to enter less information rather than more. 
The more data you enter, the more likely you are to make a typo. Also, 
the data you enter must match exactly the data in the database. If the 
original data-entry person made a typo, your match wouldn’t be found. 

 

3. Press the Do Search button.  

 

4. When your search is completed the results will display in the grid. If the COE you are 
looking for is listed, select the desired family and press the Select COE button.  MIS2000 
will then show you that COE. 

 
Establishing a List of COEs to View 

  
This Navigator Bar allows you to scroll through a list of COEs. There are three ways to establish 
the list of COEs: 

 

• To navigate through COEs for a particular student: In Student View, select the 
student whose COE(s) you want to view. From the Go menu, select To COEs. MIS2000 
will show you most recent COE for that student. You can use the arrows to move back 
and forth between that student’s COE(s). 

 

• To scroll through COEs from a Search: Do a COE Search. Close the Search window. 
You can now scroll through all the COEs who appeared in the Search Results grid. 

 

• To scroll through all the COEs in your database: Press the Search button, then Close 
the Search Window without doing a search. You can now scroll through all the COEs in 
the database. 
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Printing COEs 

In order to print COEs you must add them to the printing queue. The printing queue is a line up of 
records that are waiting to print. The records will remain in the queue until they are cleared or 
printed. 

 

1. Find the COE you want to print. 

 

2. Go to the COE menu at the top of the screen and select Queue COE. The COE will be 
added to the printing queue. To queue all the new COEs you are entering, check the 
Queue All New COEs menu item by selecting it. 

 

3. Once you have queued your COEs, select Print COE Queue from the COE menu. You 
will be given a print preview of the COEs. You can then choose to print, save, or cancel 
the COEs. 

 

4. To clear the COE queue upon printing, check the item labeled Clear queue on print on 
the print preview screen. 
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WORKING WITH STUDENT DATA 
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Understanding the Student View 

 

When you look at a student in Student View, you will see three panels.  

 
• The top panel on your screen contains data such as student name, sex, birthdate, age, and 

student ID. This data is carried over from the student’s COE. 

 

• The middle panel contains information that has been collected about the student, such as 
health, tests, supplemental programs, and school history. 

 

• The third panel is a series of buttons. When you press a button, that data appears in the 
middle panel. For example, if you press the School History button, the child’s School 
History data will appear in the middle panel.  

 

To enter student data, press the button for the type of data you want to enter. Following are 
references to the different types of student data you may be required to enter. 

 

Credit Accrual, page 22  

Family/Parent, page 24  

Health, page 25  

School History, page 26 

Special Ed, page 28 

Supplemental Programs, page 29 

Tests, page 31 
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Credit Accrual Panel 

The Credit Accrual Panel shows you the secondary school credits a student has accumulated 
toward his/her graduation requirements. Notice that there are two grids in the Credit Accrual 
Panel: the Credit Accrual grid and the School History grid. 

 

Each line in the Credit Accrual grid is linked to an enrollment in the School History grid. For 
instance, the Credit Accrual Panel may list a credit earned on 05/01/99. This credit is linked to the 
enrollment line of 09/01/98--06/01/99 in the School History Panel, because that is the enrollment 
during which the credit was earned 

 

If you click on a credit in the Credit Accrual grid, its associated SH line will be highlighted. 

 

Credit Accrual grid                 School History Grid 
 

Adding a new Credit Accrual Line: 

1. Find the student who needs the new CA line. Press the Credit Accrual button at the bottom 
of the screen. 
 

2. Before entering any new data, you need to link your new Credit Accrual line to the correct 
School History enrollment. Select the line in the School History grid to which you want 
your new Credit Accrual line to be linked. 
 

3. Press the "+" button on the Navigator Bar above the Credit Accrual grid. The white fields 
above the grid will become blank, so that you can enter your new data. 
 

4. When you have entered your data, press the checkmark on the Navigator Bar to post your 
new data. Your data will then be added to the Credit Accrual grid. 

 

Updating a Credit Accrual Line: 

1. To change a line in the Credit Accrual grid, select the line. You will see that line’s data 
autofill in the white fields above the grid. 

 

2. Make your changes in the fields, then press the checkmark on the Navigator Bar to post your 
changes. The changes will be posted to the Credit Accrual grid. 
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Did you link your Credit Accrual line to the wrong School History line? See page 34 to find out 
how to change the linking. 
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Family/Parent Panel 

The Family/Parent Panel holds information about the student’s family. The data you see in the 
Family/Parent Panel has been copied over from the student’s COE. The Family/Parent Panel is 
useful because it allows you to record current family information without changing the COE. 

 

For instance, a child’s father may have relinquished custody of the child to the mother. You want 
to record this change, but you don’t want to change the original COE. So, you just record the 
change on the child’s Family Panel and the COE remains unchanged. 

 
Changing Family/Parent Data for One Child on a COE 

1. In Student View, find the child whose Family/Parent Panel data you want to change. When 
you find the child, press the Family/Parent button at the bottom of the screen. 

 

2. Press the Set button. The Family Search screen will appear. 

 

A. To change the child’s Family/Parent data to a family that is already in the database: 

• Enter the new mother or father’s name in the white fields. Press the Do Search 
button. When MIS2000 finds the family, it will list the family in the grid. 

• Select the family in the grid and press the Select Family button. That family will 
now be displayed in the child’s Family Panel. The child’s COE will not be 
changed. 

 

B. To change the child’s Family/Parent data to a new family that is not in the database: 

• Press the New Family button. MIS2000 will give you blank fields in which to 
enter your new family data. The child’s COE will not be changed. 

 

Changing Family/Parent Data for All the Children on the COE 

1. In Student View, find one of the children whose Family/Parent data you want to change. 
When you find the child, press the Family/Parent button at the bottom of the screen. 

 

2. Make your changes in the white fields. These changes will be applied to the Family Panels of 
all the children on that child’s COE. The COE itself will not be changed, just the children’s 
Family Panels. 
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Health Panel 

 

The Health Panel holds data about the student’s health history. The Health panels for most states 
contain several different charts. Each chart has a tab at the bottom of the Health Panel. To view 
the data located on another tab, click on it and that chart will appear. 

 

  
This Health Panel has four charts:.Tests, Vitals, Medical Alert, and School Specific. 

 
Entering and Updating Health Data 

1. Find the student who needs the Health data. 

2. Press the Health button at the bottom of the screen. 

3. Select the tab for the chart on which you want to enter data. 

4. Enter your data. MIS2000 will save your changes for you. 
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School History Panel 

 

The School History Panel holds information about students’ school enrollments. The School 
History panel is connected to other panels that your state may have, such as the Tests panel, 
Supplemental Programs panel, and Credit Accrual Panel.  

 

  
Here is an example of a School History Panel. You type your data in the white fields, and it is 
saved in the grid. 

 

  
NOTE: When you enter a new child on a COE, that enrollment data, such 
as Facility Name and Enroll Date, will be copied over into the School 
History grid in Student View. 

 
Adding a new School History Line: 

1. Find the student who needs the new SH line. Press the School History button at the bottom 
of the screen. 

 

2. Press the "+" button beside the School History grid. The white fields above the grid will 
become blank, so that you can enter your new data. 

 

3. When you have entered your data, press the checkmark on the Navigator Bar to post your 
new data. Your data will be entered as the top line in the School History grid. 

 
Updating a School History Line: 

1. To change a line in the School History grid, select the line. You will see that line’s data 
autofill in the white fields above the grid. 
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2. Make your changes in the fields, then press the checkmark on the Navigator Bar to post 
your changes. The changes will be made in the School History grid. 
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Special Ed Panel 

 

For each enrollment in your School History grid, you can add Special Education information if 
necessary. 
 

Adding Special Ed data to a School History line 

1. Find the student who needs the Special Ed data. Press the Special Ed button at the bottom 
of the screen. 
 

2. You will see a grid partially filled with School History Data. Select the School History line 
to which you want to add Special Ed data. 

 

  
Special Ed Data     School History Data 

 

3. Enter your Special Ed data in the white fields above the grid. MIS2000 will save your data 
for you. The next time you pull up the Special Ed Panel, the data you entered will display 
when you select the School History line. 

 
Updating Special Ed Data 

1. Select the School History line to which your Special Ed data is connected. The Special Ed 
data will autofill in the white fields above the grid. 

 

2. Edit the data. MIS2000 will save your changes for you. The next time you pull up the 
Special Ed Panel, your changes will be reflected in the grid. 
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Supplemental Programs Panel 

The Supplemental Programs Panel shows you any special programs in which the student has 
participated. Notice there are two grids in the Supplemental Programs Panel: the Supplemental 
Programs grid and the School History grid.  
 

Each line in the Supplemental Programs grid is linked to an enrollment in the School History 
grid. For instance, the SP Panel may list a SP that started on 10/14/98 and ended on 01/26/99. 
This SP is linked to the enrollment line of 09/01/98--06/01/99 in the School History Panel, 
because that is the enrollment during which the student participated in the SP. 
 

If you click on an SP in the SP grid, its associated SH line will be highlighted. 
 

  
Supplemental Programs Grid    School History Grid 
 

Adding a New Supplemental Programs Line 

1. Find the student who needs the new SP. Press the Supplemental Programs button at the 
bottom of the screen. 
 

2. Before entering any new data, you need to link your new Supplemental Program line to the 
correct line in the School History grid. Highlight the line in the School History grid to which 
you want your new SP data to be linked. 
 

3. Press the "+" on the Navigator Bar above the Supplemental Programs grid. The white fields 
above the grid will become blank, so that you can enter your new data. 
 

4. Enter your data, then press the checkmark on the Navigator Bar to post you new data. Your 
new data will be posted into the Supplemental Programs grid. 

 
Updating a Supplemental Programs line 

1. To update a Supplemental Programs line, select the line you wish to update. That line’s data 
will autofill in the white fields above the grids. 
 

2. Make your changes in the fields, then press the checkmark on the Navigator Bar to post 
your changes. Your changes will be posted to the Supplemental Programs grid. 
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Did you link your Supplemental Program line to the wrong School History line? See page 34 find 
out how to change the linking. 
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Tests Panel 

The Tests Panel shows you the tests a student has taken. Notice that there are two grids in the 
Tests Panel: the Tests grid and the School History grid.  
 

Each line in the Test grid is linked to an enrollment in the School History grid. For instance, the 
Tests Panel may list a test taken on 05/01/99. This test is linked to the enrollment line of 
09/01/98--06/01/99 in the School History Panel, because that is the enrollment during which the 
test was taken. 
 

If you click on a test in the Tests grid, its associated SH line will be highlighted. 

 
Tests grid                                 School History Grid 

 

Adding a new Test Line 

1. Press the Tests button at the bottom of your Student View screen. 
 

2. Before entering any new data, you need to link your new Test line to the correct School 
History enrollment. Highlight the line in the School History grid to which you want your 
new Test line to be linked. 

 

3. Press the "+" button on the Navigator Bar above the Tests grid. The white fields above the 
grid will become blank, so that you can enter your new data. 
 

4. Enter your data, then press the checkmark on the Navigator Bar to post your new data. Your 
data will be posted to the Tests grid. 

 

Updating a Test Line 

1. To change a line in the Tests grid, select the line. You will see that line’s data autofill in the 
white fields above the grids. 

 

2. Make your changes in the fields, then press the checkmark on the Navigator Bar to post your 
changes. The changes will be posted to the Tests grid. 

 

Did you link your Test line to the wrong School History line? See page 34 to find out how to 
change the linking. 
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Student Records 

In order to print Student Records you must add them to the printing queue. The printing queue is 
a line up of records that are waiting to print. The records will remain in the queue until they are 
cleared or printed. 

 

You can print Student Records from Student View or from COE View: 

 
Printing Student Records from Student View 

1. Find the student record you want to print by navigating to it or searching for it. 

 

2. Go to the Reports menu, then choose Queue Record.   

 

3. Repeat this process to queue as many student records as you want. 

 

4. If you wish for health data to appear on the printed records, click on the Reports menu item 
labeled Include Health Data until you see a check beside it. 

 

5. Once you have queued all your records, select Print Queued Records from the Reports 
menu. A preview of the queued Student Records will appear on the screen. You can then 
choose to print or cancel the queued records. 

 

Printing Student Records from COE View 

1. Find the COE that includes the student whose record you want to print. Find the COE by 
navigating to it or searching for it. 

 

2. Press the Children button at the bottom of the screen. 

 

3. Select the child whose record you want to print. 

 

4. From the Reports menu, select Queue Record.  

 

5. Repeat this process to queue all the children you want. 
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6. From the Reports menu, select Print Queued Records. A preview of all the queued 
records will appear on the screen. You can then choose to print or cancel the queued 
records. 

 

  
NOTE: You can also queue students by using the Student List feature on 
the Student Search window. 

 
Clearing the Record Queue 

There are two ways to clear records out of the record queue: 

 

• Go to the Reports pull-down menu and select Clear Record Queue. MIS2000 will ask 
you if you want to clear all records in the queue. Press OK. 

 

• From the Reports pull-down menu, select Print Record Queue. Check the field labeled 
Clear Queue on Print. The queued records will now be automatically cleared once they 
have printed. 
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Changing Grid Linking 

 

If you linked a Test line, Supplemental Program line, Special Ed line, etc. to the wrong School 
History line, you can change the linking: 

 

1. Highlight the Test, SP, etc line that is incorrectly linked. 

 

2. Uncheck the Lock Enrollment Window field. 

 

3. Highlight the correct School History line.  

 

4. Press the checkmark in the Navigator Bar to save your changes. 

 

5. Check the Lock Enrollment Window field. 

 

Your line should now be linked to the correct School History line. 
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NOTES 
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SEARCHING FOR STUDENTS 
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Understanding the Student Search Window 

 

  
 

Whenever you want to look for a student in the database, this is the Search Window you will use. 
You can get to the Student Search window in Student View by pressing the Search Student 
button. You can get to the Student Search window in COE View by pressing the New 
Enrollment button on the Children panel. 

   

There are 6 tabs across the top of the Student Search window: 
 

Key Data tab allows you to search your own database or the state database for one student at a 
time. 
 

District/Facility tab allows you to search your database by District or Facility. 
 

SQL tab allows you to search using Standard Query Language (SQL). This tab is for MD/EdD 
staff.  
 

Student List tab allows you to create a list of students that you can the scroll through, or queue 
for printing. This is a time-saving feature that is helpful if you need to add data to a group of 
students, but don’t want to do an individual search for each one. It is also a faster way to send a 
group of student records to the printing queue. 
 

Batch Search tab allows you to search your state database for a group of students. 
 

Locator tab allows you to search the MIS2000 National Locator for students. If you would like 
for your state to become part of the MIS2000 National Locator, please contact MS/EdD. 

 

How do I search my own database for a student? See page 38 to learn how. 

How do I search the state database for a student? See page 39 to learn how. 

How do I search the state database for a group of students? See page 40 to learn how. 
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Searching Your Database for One Student 

 

  
If you have the Student ID of the Student you’re looking for, the 
quickest way to access that student is to type the ID number in the 
Student ID field at the top left of your screen and press Return. Or, 
you can search with the following steps: 

 

1. From Student View, press the Search Student button . 

 

2. On the Key Data tab, fill in your data and press the Do Search for Child button to search 
your database.  

 

  
NOTE: It is sometimes best to enter less information rather than 
more. The more data you enter, the more likely you are to make a 
typo. Also, the data you enter must match exactly the data in the 
database. If the original data-entry person made a typo, your match 
wouldn’t be found. 

 

3. When your search is completed the results will display in the grid.  If the student you are 
looking for is listed, select the desired student in the grid and press the Select Child button. 

 

See page 39 to learn how to search the state database. 
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Searching the State for One Student 

 

1. Press the Student Search button in Student View.  

 

2. On the Key Data tab, fill in the data for the student you are looking for. Remember, it is 
better to enter less data than more, for the chance of typos increases the more data you enter.  

 

3. Press the Search Remote button. 

 

4. If found on the state database, the student’s data will appear in the grid.  

 

5. Select the student and press the Download Student button. 

 

6. Once the student has been downloaded to your database, press the Do Search for Child 
button to find that child on your database. 

 

7. Press the Select Child button to view that student’s data. 

 

See page 40 to learn how to search the state for a group of students at once. 
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Searching the State for a Group of Students (Batch Searching) 

 

When you get a batch of COEs, it is important that you search the state database for the students 
on the COEs before you enter the COEs. If a student is already entered into the state MIS2000 
database, you need to download that student to your database. You will then add that existing 
Student Data to the new COE. 

 

Batch searching is a way for you to search the state for a group of students. You can search for all 
the students on your COEs, and download any students that you find at the state. Then, when you 
enter your COEs, the students will already be downloaded to your computer. You just have to add 
the students to the COEs. 

 

1. Open the Student Search window by pressing the Search Student button in Student View.  

 

2. On the Batch Search tab, press the New Batch button to clear out your last batch.  

 

3. Enter the data for the first student you are looking for. Remember, it is better to enter less 
data than more, for the chance of typos increases the more data you enter.  

 

  
NOTE: Entering the student/COE ID will exclusively identify the 
student (no two students should have the same ID) 

 

4. Press the New Search button. The student’s name will be added in the top grid. (Each 
individual student you search for is considered a "search"). 

 

5. Follow steps 3-4 to add all the students you are searching for in the top grid. 

 

6. When you have finished entering your list of students, press the Search the State button. 

 

7. You will see a message at the bottom of your screen stating, "Batch submitted. Check later 
for results."  

 

8. Keep pressing the Check button until you get a message stating that your search is 
completed. 

 

9. Click on the first student in the top grid. Any matches found at the state will appear in the 
bottom grid. Check the birthdate, parent’s names, etc. to determine if this record from the 
state (in the bottom grid) is the same student that is on your COE.  
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10. If you determine that it is the same student, click in the Get column beside the student’s 
name. A "Y" will appear, marking this student for download. 

 

11. Follow steps 9 and 10 to mark all the students you want to "Get". 

 

12. When you have marked all of the students you want to download with a "Y", press the 
Download Students button. All of the selected students will be downloaded onto your 
computer. You can then add them to COEs. 

 

See page 15 to learn how to enter COEs. 
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Using the Student List feature 

The Student List function is helpful if you want to "gather together" a group of students to put in 
the printing queue, or to scroll through for editing. If you were working with paper COEs and 
wanted to edit twenty paper COEs, you would probably gather the twenty paper COEs into a 
stack and then begin your editing. You can essentially do this with the Student List function. 

 

For example, you may have twenty students from different facilities to whom you need to add 
Enrollment data. Rather than searching for those students one at a time, you can create a list of 
those twenty names. Then you could scroll though the students from the list and edit their records 
without having to do individual searches.  You could also send the list of twenty students to the 
printing queue to be printed. 

1. Open the Student Search window by pressing the Student Search button in Student View. 

 

2. Search your database for the first student you want to add to the list. 

 

3. When the child is found on your database, select the child and press the Add to List button. 

 

4. Follow steps 2-3 to add the rest of the students to the list. 

 

5. Select the Student List tab: 

• Press the Use the List button if you wish to scroll through the students on your list. 

• Press the Queue All button to send the list to the printing queue. 

• Press the Clear All button to clear the list. 

 

  
NOTE: You can add students to the Student List from the Key Data tab or 
the District/Facility tab. 
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Using the District/Facility feature 

The District/Facility function allows you to search your database by district or facility. You can 
then view students from your search, or you can add the students to the Student List. From the 
Student List tab, you can send all the students from the district or facility to the printing queue to 
be printed. 

 
Searching by Facility 

1. Enter the Facility Name or the Facility Code and hit the Tab key. The other field will 
fill in for you. 

 

2. If you want to limit your search to students whose enrollments are within certain dates, 
enter the dates in the From and To fields. 

 

3. Press the Facility Search button.You can then: 

• Select the child you want to view and press the Select Child button. 

• Select the child you want to add to the Student List and press the Add to List 
button. The child will then be added to the Student List on the Student List tab. 

• If you want to add all the students to the Student List, press the All button. All 
the students from that facility will be added to the Student List. 

 
Searching by District 

1. Enter the District Name in the District field. 

 

2. If you want to limit your search to students whose enrollments are within certain dates, 
enter the dates in the From and To fields. 

 

3. Press the District Search button.You can then: 

• Select the child you want to view and press the Select Child button. 

• Select the child you want to add to the Student List and press the Add to List 
button. The child will then be added to the Student List on the Student List 
tab. 

• If you want to add all the students to the Student List, press the All button. 
All the students from that district will be added to the Student List. 
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NOTES 
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WORKING WITH YOUR STATE DATABASE 
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Uploading changes to your state computer 

 

When you do an upload to the state computer, the work you have done in MIS2000, such as 
entering COEs and adding enrollment information, will be copied to the state database. You 
should do an upload to your state database every day that you enter data. The state database 
should always have an updated copy of your work. 

 

1. Go to the Procedures menu, then select Upload Changes. The Upload Status window will 
appear.  

 

2. Press the Begin Upload button. When your changes have finished uploading to the server, 
you will see one of two things: 

 

• If your upload has finished without any problems, you will get a message saying, 
"Your upload has completed successfully." Your upload has not completed 
successfully until you see this message!  
 

You can now close the upload window. Your upload is finished. 

 

• If your upload encountered problems, you will get a status report with directions for 
making corrections, if necessary. If the status report isn’t clear, contact MIS2000 
technical support. 

 

If you do receive a status report, you should print it out by pressing the Print button. 

 

3. You will then see this window: 

  
 

4. Press the OK button. If there is an upgrade available, the upgrade will begin downloading to 
your computer. Once it finishes, you will get a message telling you to reboot your computer. 
Reboot at that time. 
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SPECIAL FUNCTIONS 
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Enrolling a group of students (Mass Enroll) 

 

Mass Enroll is a procedure that allows you to apply a common enrollment date to more than one 
student in a particular school. So, if you need to enroll 150 children from the same school on the 
same enrollment date, you can do it easily with Mass Enroll. 

 

  
Mass Enroll is one of the most customized aspects of MIS2000.  Following 
are instructions for a generic Mass Enroll. Contact your state MIS2000 
coordinator to find our more about your Mass Enroll screen. 

 

1. From the Student or COE view, open the Procedures menu, and then select Mass Enroll. 
The Mass Enrollment dialog field will appear. 

 

2. Type in the Facility Code or the Facility Name, and the other will fill in automatically. 
 

3. Tab to Enroll Date and enter the new enrollment date.  
 

4. Tab to Type and enter the new enrollment type. 
 

5. Press the Do Search button.  It varies from state to state, but the general rule is that all 
students whose Most Recent Enrollment is in that facility will appear in the grid. 
 

6. Enter the New Grade for each child that is to be re-enrolled. Or, you can check the Grade 
Rollup field. Then each child with an "X" in their Do column will automatically be enrolled 
in the next highest grade.  
 

7. If necessary, enter the New Facility ID. 
 

8. After entering your data for all the students to be re-enrolled, press the Do Enroll button. 
The students are now enrolled. MIS2000 will display a printable report showing which 
students were enrolled and which students were ignored. 

 

 
NOTE: Your version of MIS2000 may have field for 
Begin Date and End Date. These are dates you can use 
to limit the number of enrollments to be listed. For 
instance, you can choose to look at all enrollments 
between August 1999 and May 2000. 
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Withdrawing a group of students (Mass Withdraw) 

 

Mass Withdraw is a procedure that allows you to apply a common withdrawal date to more than 
one student in a particular school. For example, if you have to withdraw 150 children from the 
same school on the same date, you can do it easily with Mass Withdraw. 

 

  
The Mass Withdraw screen is customized for each state.  Following are 
instructions for a generic Mass Withdraw. Contact your state MIS2000 
coordinator to find our more about your Mass Withdraw screen. 

 

1. From the Student or COE view, open the Procedures menu, and then select Mass 
Withdraw. The Mass Withdrawal window will open. 

 

2. Type in the Facility Code, and tab to Facility Name. The facility name will autofill in the 
field. Or, type in the Facility Name and the Facility Code will autofill. 

 

3. Tab to Withdraw Date and enter the new withdrawal date.  

 

4. Press the Do Search button. A list of students whose Most Recent Enrollment is in that 
facility, and who don’t have a withdraw date, will appear in the grid. A student must have an 
enrollment date in order to be withdrawn! 

 

5. Now you can type in your enrollment data for each student, such as "days enrolled" and 
"days present." If you type anything in either of these two fields, MIS2000 will 
automatically add the data to that child’s school history line and withdraw the student. 

 

6. If you don’t have any enrollment data, such as "days present" and "days enrolled," just place 
an X (or any letter) in the withdraw field to the left of the screen. This will cause the student 
to be withdrawn. 

 

7. After marking all the students who need to be withdrawn, press the Do Withdraw button. 
The students are now withdrawn. 



06�(G'�
Management Services for Education Data 

�
 

50 MIS2000 User’s Guide 
 

Adding SP data to a group of students (Mass SP) 

 

Mass Supplemental Programs is a procedure that allows you to add one or more SPs to a group of 
students from the same school. If 100 students from a facility need to have one or more SPs 
added, you can add them all at once with Mass SP.  
 

Adding Mass SPs 

1. From Student or COE view, click on the Procedures menu. Then select Mass SP. 
The Mass SP dialog field will appear. 

 

2. If you are adding just one SP to the students, select the By Single SP Codes tab. If 
you are adding a group of SPs to the students, select the By SP Group Codes tab. 

 

3. Type in the Facility Code or the Facility Name, and the other will fill in 
automatically. 

 

4. In the SP Code or SP Group field, select the code you wish to add to the students. 
Or, select the name in the SP Description field. The other field will fill in for you. 
(An SP Group Code is a letter that stands for a group of SPs. When you choose that 
letter, all of the SPs in the Group are added to the students. For information on 
creating SP Groups, please read on).  

 

5. Enter the funding code in the Funding Code field.  
 

6. Enter the start and end dates for the SPs in the Start and End fields. Or, if you want 
to use the student’s school enrollment and withdrawal dates as the Start and End 
Dates, just check the Use Enr and Use Withdraw fields. 

 

7. If you want to limit the enrollments to enrollments after a certain date, enter the date 
in the Enrollments Since field. 

 

8. Press the Do Search button. A list of students whose most recent enrollment is in that 
facility will appear in the grid. 

 

9. Place a Y (or any letter) in the Do field for all the students who need to have the 
SP(s) added. Or, check the Do All box to add the SP(s) to all the students listed. 

 

10. Press the Add SPs button. 

 

MIS2000 will display a printable report showing the students who had SPs added, and the 
students whose records were ignored. 

 
What if the SP Group you want to add is not included in the drop-down list in your "By SP Group 
Codes" tab? Then you will need to create the SP Group yourself. Here’s how: 
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Defining your SP Group 

  
NOTE: If you are going to create your own Mass SP Codes, you should 
coordinate this with the state site so that everyone has the correce codes. 

 

The first thing you have to do is tell MIS2000 which SPs you want to add to the students. For 
example, let’s say that you want to add Even Start and Needs Assessment to a group of students. 
You will tell MIS2000 that you are making an SP Group consisting of Even Start and Needs 
Assessment, and that you are calling this group Group A. Once you have defined your group, you 
don’t have to do it again. MIS2000 will always know that Group A consists of Even Start and 
Needs Assessment. 

 

You define your SP groups with the Edit Codes dialog. (If you do not have a basic understanding 
of Edit Codes, see page 53 to learn more).   

 

1. Go to the Procedures menu, and choose Edit Codes. 

 

2. In the Select Code Table field, select the SP Group Code code table. 

 

3. Make up a one-character code (it can be a letter or numeral) for your group and type 
it in the GroupCode field in the grid. 

 

4. In the Description field, make up a name for your group. 

 

5. In the SPCode field, type in the SP code for the first SP you want to add to the group 
(if you need to look up an SP code, you can find a list of SP codes in the 
Supplemental Program Code code table). 

 

6. In the Funding field, type in funding code of the SP (Migrant, Title 1, etc) 

 

7. To include more than one SP in the group, click anywhere in the right grid and press 
the Insert button. MIS2000 will give you blank fields. Fill in the new blanks with the 
second SP Code and its funding. 

 

Example:  I want to add two SPs to a group of students: Even Start and Needs Assessment.  

 

• I would go to Procedures| Edit Codes and choose the SP Group Code  table.  

• I would then make up a code for my SP group: A, and enter it in the Group Code field.  

• Next I would make up a Description: Even Start and Needs Assessment. 

• In the SP Code fields I would enter my SP Codes: 001 for Even Start and 002 for Needs 
Assessment. 
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• In the Funding fields I would enter the funding code: M for Migrant. 

 

  
Now Group A consists of Even Start and Needs Assessment. 

 

Now you are ready to add your Mass SPs to the students. 
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Editing the Contents of drop-down lists (Editing Codes) 

 

The Edit Codes function allows you to add, update, and delete entries from lists of information 
such as the Facility list, Test Codes list, Supplemental Programs list, etc. Here is an example of 
when you might want to use the Edit Codes feature: Let’s say you are entering a parent 
relationship and accidentally type in "Mothr" instead of "Mother" You could remove the 
mispelled entry with the Edit Codes dialog. 

To access this feature, open the Procedures menu and then select Edit Codes. The Code Table 
Edit dialog field will open.  
 

To add a new entry: 

1. Click on the Select Code Table drop-down button and scroll down the displayed list. Select 
the code table you want by clicking on it. 
 

2. Click anywhere in the displayed grid and press the Insert key. This will result in a blank 
line in the grid. 
 

3. Enter your data into the new line. MIS2000 will alphabetize your entries for you. 
 

4. Press the Close button after entering your data. The dialog field will close and you will be 
returned to either the Student screen or the COE screen, depending on where you were 
previously.  

 

To update an existing entry in a code table: 

1. Click on the Select Code Table drop-down button and scroll down the displayed list. Select 
the code table you want by clicking on it. 
 

2. To update an existing entry within a code table, move the cursor to the field you wish to edit 
and click on that field. Make your changes. When you are done, press the Close button. 

 

To delete an entry in a code table: 

      Select the entry you wish to delete. Hold down on the Control key and hit the Delete key.  
 

To find a particular entry in a code table: 

1. Click on the Select Code Table drop-down button and scroll down the displayed list. Select 
the code table you want by clicking on it. 
 

2. Type in the name of the entry you are looking for in the white field next to the word "Key." 
Press the Find button. 
 

3. The table will now jump to the field you have specified. 
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NOTE: Some Code tables have several indexes from which you may 
choose. For example, your Facility table may offer you indexes that 
sort the list by name and by district. Choose the index you wish to 
use by clicking on the Select Index List Button. 
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Checking for duplicate students 

 

No student should have more than one record in your state (although students can appear on more 
than one COE.)  
 

The following procedure will help you determine which students in your database may have 
duplicate records. MIS200 can only guess at this. It is up to you to investigate the potentially 
duplicated students to determine if they really are duplicates, or if they are just students with 
similar information. 

 

1. Go to the Reports menu at the top of your screen. Select Potential Duplicate Students. 

 

2. There are four ways to search for students who may have more than one record in your 
database. Check the Only Recent Records item to limit your search to records that have had 
activity within the last three years. 

 

• Matching DOB: DOBs must match and first three letters of first and last name must 
match. 

 

• Close DOB: At least two parts of DOBs must match and first five letters of first and last 
name must match. 

 

• Potentially Adopted Duplicates: Finds records with identical first names, DOBs, and 
birth cities, but different last names. These students have been adopted and had their last 
name changed. 

 

• Same SSN: Finds records with identical Social Security Numbers. 

 

  
NOTE: If you hover your mouse over the above menu items, their 
descriptions will appear in the bottom left corner of your screen. 

 

3. Select the method you wish to use to search for potential duplicate students by clicking on it. 
MIS2000 will immediately begin scanning the database for duplicate students who match the 
criteria you selected. Once it is finished, MIS2000 will show you a list of duplicate students 
who matched your criteria.  

 

4. Once you determine who your duplicate students are, the duplicates will need to be merged.  
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Merging duplicate students 

Merging duplicate students is a complicated procedure. If you are at a regional site, always 
coordinate merges with your state site. Please contact MIS2000 support if you need assistance 
with merging duplicate students. We are working on this process to make it easier! 

 

The following is a step-by-step checklist for merging a list of duplicate students: 

 

1. Make a two-column list of the Student IDs to be merged. Each duplicate student will have 
two different Student IDs. 

 

2. Give this list to each regional site. 

 

3. At each regional site, if they have either record in a pair, they must download both records 
in the pair. Use the Student Search panel to download records. 

 

4. After each regional site has completed their downloads, the state site may then merge all the 
pairs on the list. 

 

5. After completing the merges, visit each merged record and delete any duplicate lines. Do 
any clean up that is appropriate. 

 

6. Now each regional site must merge each pair they downloaded in step 3. 

 

7. Now each regional site must download their students again, just like they did in step 3 
except this time it is only necessary to download one ID in each pair, since the pairs have 
been merged. 
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REPORT BUILDER 
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What is Report Builder? 

Report Builder is a tool which allows users to create their own reports in MIS2000.  If you need 
to know how many students are enrolled in a particular school, or the names of students who 
scored a particular grade on a test, Report Builder will make it easy for you. 

 

Report Builder is made up of three parts: Selector, Designer, and Snap Reports.  

• Selector allows you to choose the student or COE data that you want included in your 
report.  

 

• Designer allows you to format your Select data and make you report look polished and 
professional. 

 

• Snap Reports allows you to quickly run reports that have already been created. 

 

The best way to learn how to use Report Builder is to read the Selector Guided Tour, then work 
through the Selector and Designer Tutorials.  
 

See page 59 to begin a guided tour of Selector, the basis of all your reports. After you have read 
the Selector Guided Tour, work though the Selector Tutorials (starting on page 62). 
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Selector: An Overview 

Report Tab 

This tab gives you a list of the Report Types you can base your report on. For example, you can 
base your report on all enrollments in your database, or on the most recent enrollment for each 
student. You can base your report on the facility information in your database, or on COE 
information. 

 

Reports with "count" in parentheses are reports that give you a count rather than a list. For 
example, if you choose "All Enrollments," the report will generate a list of all the enrollments in 
your database. If you choose "All Enrollments (Student Count)" you will be given a count of 
students appearing on the report. 

 

To select a Report Type, simply click on it, and a list of tables included in the Report Type you 
selected will appear. You are now ready to move to next step. 

 

  
 

         
Comparisons Tab 

The Comparisons tab is where you define what records you want to see. For example, you can tell 
Selector to show you only students in a particular district, or only students with enrollment dates 
within a certain year.  You can add unlimited comparisons to any report. 
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Display Fields Tab 

The Display Fields tab is where you choose which fields you want to be displayed in your report. 
You can display unlimited fields on any report. 

 
Sort Fields Tab 

The Sort Fields tab is where you can choose the order in which you want your report to be listed. 
For example, you can dictate that you want your report ordered by last name, or by enroll date, or 
by district code. 
 

Sorting on more than one field 

You can sort on more than one field. For instance, you could sort by Region Code, District Code 
and Last Name. The sort field that is listed first will be sorted first. The sort field listed second 
will be sorted second, and so on.  
 

For example, say that you added two sort fields to your report: District Code and Last Name. If  
District Code is listed first, all the entries in your report will be sorted by district. All the "District 
A’s" will be together, all the "District B’s" will be together, etc. Then, within each District Code, 
the students will be sorted by Last Name.  
 

If you sorted by Last Name first, then by District Code, the entries would be sorted first in 
alphabetical order by last name. Then, within each last name (the Smith’s for example), the 
districts would be listed in order. 
 

Moving Sort Fields Up and Down 

To move a sort field up or down, select the field in the large white field. Then press the Move Up 
or Move Down button. The field will move up or down, accordingly.  
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SQL Tab 

The SQL translates your Selector settings into Standard Query Language (SQL).  The SQL tab is 
for display purposes only, and is unnecessary for building or running reports. 

 

      
Results Tab 

The Results tab is where you run, print, and save your report.  

 

To run your report,  press the Run Query button.  

 

To print your report results, press the Print Query button.  

 

To save the results of your report, press the Save as Table button. This will save a copy of the 
data as it appears in the results grid.  You can choose where you want to save your report. Your 
report will be saved as ReportName.db (See page 70 for more information). 

 
Snap Setup Tab 

This tab is where you can modify reports to be run in Snap Reports. Snap fields listed here will be 
available as filters in Snap Reports. Also, this tab allows you to prepare your Select Data for 
Designer.  
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Basic Selector Tutorial 

This tutorial will only take a few moments, and will teach you how easy it is to create your own 
custom reports. The easiest way to use this tutorial is to print it by pressing the Print button at the 
top of this help screen.  

 

1. Open the Report menu at the top of the MIS2000 screen, then select Report Builder. 

 

2. You may want to mazimize the Selector window by pressing the square in the top right 
corner of the window. 

 

3. Notice that there are 7 tabs across the top of the Selector screen. The first tab is the Report 
tab, and it will be open. 

 

4. Uncheck the Advanced tab for now. 

 

5. Press the New Report button. 

 

  
 

6. From the Report tab, click on All Enrollments. Wait until you see the list of tables appear 
in the white field to the right before moving on to the step 7. 

 

7. Click on the Display Fields tab. Click on the + beside the Student table to open it. 

 

8. Click on Last Name to select it, then press the Add Display Field button. You will see 
"Student.Last Name" appear in the large white field. 

 

9. Repeat step 6 to add First Name to your report. Now students’ first and last names will 
appear on your report. 

 

  
Your screen should look like this. 

 

  
NOTE: You can also double-click on a field to add it to the display list. 
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10. Click on the Sort Fields tab. Open the Student table and select Last Name. 

 

11. Press the Add Sort Field button. "Student.LastName" will now appear in the large white 
field. Your report will now be sorted by last name. 

  
Your screen should look like this. 

 

  
NOTE: You can sort on more than one field. For instance, you could create 
a report and sort it by District Code and Last Name. The sort field that is 
listed first will be sorted first. The sort field listed second will be sorted 
second, and so on.  
 

For example, say that you added two sort fields to your report: District Code 
and Last Name. If  District Code is listed first, all the entries in your report 
will be sorted by district. All the "District A’s" will be together, all the 
"District B’s" will be together, etc. Then, within each District Code, the 
students will be sorted by Last Name.  

 

12. Press the Results tab, then press Run Query.  This report shows you the names, in 
alphabetical order, of all the enrollments in your database. 

 

Congratulations, you have just created a report! See how easy it is? 

 
Exercise 

Based on the above steps, create an All Enrollments report that displays Sex, Race, and Last 
Name. Sort your report by Race 
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Intermediate Selector Tutorial 

Now, let’s create an enrollment report in Selector. This may look like a lot of steps, but it’s really 
quite easy and fast! This tutorial should take no longer than 10 or 15 minutes.  

 
Choosing the Type of Report you want to Create 

1. Open the Report menu at the top of the MIS2000 screen, then select Report Builder. 

 

2. Press the New Report button. 

 

3. On the Report tab, click on All Enrollments. Wait until you see the list of tables appear in 
the white field to the right before moving on to the next step. 

 
Choosing the Fields you want to Display 

1. Click on the Display Fields tab. Click on the + beside the Student table to open it. 

 

2. Click on Last Name to select it, then press the Add Display Field button. You will see 
Student.Last Name appear in the large white field. 

 

3. Use steps 2 and 3 to add First Name, Birthdate, and Student Seq to your report. 

 

4. Click on the -- to close the Student table, and click on the + to open the Facility table. Add 
FacilityName to your report. 

 

5. Open the School History table and add Grade and Enroll Date to your report. 

 

 
Your screen should now look like this. These are the six fields that will be displayed on your 
report. 
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Limiting the Data to be included in your Report 

1. Click on the Comparisons tab. Open the School History table and select Enroll Date. 

 

2. Click in the white circle beside Between.  

 

3. Click in the top white field. Enter 09/01/99. Tab to move your cursor to the bottom white 
field.  Type 05/01/00 in the bottom field (You can enter whatever dates you want). 

 

4. Press the Add Comparison button. Your comparison will appear in the large white field. 

 
5. Open the Facility table. Select Facility Name. 

 
6. Click in the white circle beside =. 

 
7. Click in the top white field. Enter a facility id from your state.  

 
8. Press the Add Comparison button. Your comparison will appear in the large white field. 

 

Y
our screen should look something like this. This report will now display students with an 
enrollment in facility TNCZCV between 09/01/99 and 05/01/00. 
 
 

  
NOTE: You can use the Comparions tab to limit your report by Grade, 
City, Enrollment Type, QAD Date, Res Date, etc. For instance, you could 
limit your report to students with a Res Date before 09/01/00. You could 
look at students who have an SP Code of 102. Be creative! 
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Sorting your Select Data 

1. Click on the Sort Fields tab. Open the Facility table and select Facility Name. 

 

2. Press the Add Sort Field button. 

 

3. Open the School History table and select Grade. Press the Add Sort Field button.  

 

4. Close the Facility table by pressing the minus sign beside Facility.  Open the Student table 
and select Last Name. Press the Add Sort Field button. 

 

Your screen should look like this. Your report will now be sorted by Facility Name, then Grade, 
then student Last Name. 
 

  
To move a sort field up or down, select the field in the Sort Field field. 
Then press the Move Up or Move Down button. The field will move up or 
down, accordingly.  

 
Getting your Select  Results 

From the Results tab, press the Run Query button. In a few moments, you will see a table 
containing the results of your report. 

 
Saving your Select Settings and Select Results 

When you create a report, you may want to save it so that you can run the report at a later date. 
There is a difference between saving your Select Settings and your Select Results.  

 

• Your Select Results is the table you get when you press the Run Query button. Press the 
Save as File button to save your results table as a text file. Press the Save as Table 
button to save your results as a ".db" file. The text or .db file could then be imported into 
software such as Microsoft Word or Access to be viewed.  

 

• When you save your Select Settings you are saving the report type, display fields, 
comparisons, and sort fields that you chose for your report. If you think you may want to 
run these Select Settings again, you will need to save it: 
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To save your Select Settings: 

1. Press the Save As button on the Report tab. The Save Report window will open. 

 

2. Enter the name SelectorTutorial in the File Name field.  

 

3. Look at the Save In box to see where you are saving the file. MIS2000 should 
automatically open the MIS2000 folder, which is right under your C drive (it may be 
right under another drive.) We recommend saving your reports in your MIS2000 
folder. 

 

4. Press the Save button. Your Select Settings will be saved as an R2K file. 

 

 
 NOTE: You can reload your R2K file at any time: Press the Load From button 
on the Report tab. When the Open Report window pops-up, select the name of 
the R2K you want to open, and press the Open button. Your R2K will open, and 
you can then run or edit it. 

Congratulations! You have now completed an intermediate report! Reporting is 
getting easier, isn’t it?  

 

 
Exercise 

Create a report that displays female students with an enroll date between two dates (hint: you will 
need to make two comparisons). Display student Last Name and First Name, family Last Name 1 
and First Name 1 (or any parent name field), and Facility Name. Sort the students’ last names 
alphabetically. 
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Advanced Selector Tutorial: Using "And/Or" Groups 

Sometimes it is helpful to make "and/or" groups in Selector. For example, you may want a list of 
students who live in either "district 123" OR "district 456." The following tutorial shows you 
how to create "or" groups. (In this tutorial we will not create an entire report; just the "and/or" 
part) 

 

1. Press the New Reports button on the Report tab 
 

2. Select All Enrollments from the Report tab. 
 

3. Click on the Comparison tab. 
 

4. Open the School History table and click on Grade. 
 

5. Click on the white circle beside the =. 
 

6. In the top white field, type 8. Press the Add Comparison button. 
 

7. In the top white field, delete the 08 and enter 12. Press the Add Comparison button. 
 

Your screen should look like this. 
 

8. Now, select both comparisons. To select two things at once, click on the first item. Then 
hold down on the Control key and click on the second one. 

 

9. Once you have both items selected, press the Make OR Group button.  
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Your screen should look like this.  Your report will now show you any students in eighth grade or 
twelfth grade. 
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Saving your Select Settings and Results  

When you create a report, you may want to save it so that you can run the report at a later date. 
There is a difference between saving your Select Settings and your Select Results.  

 

• The Select Results is the table of data you get when you run your query. The Select 
Results is your asnwer set. 

 

• When you save your Select Settings you are saving the report type, display fields, 
comparisons, and sort fields that you chose for your report. Your Select Settings is 
your report design. 

 

 

Saving your Select Settings (your report design): 

1. Press the Save As button on the Report tab. The Save Report window will open. 

 

2. Enter the Report Name in the File Name field.  

 

3. Look at the Save In box to see where you are saving the file. MIS2000 should 
automatically open the MIS2000 folder, which is right under your C drive (it may be 
right under another drive.) We recommend saving your reports in your MIS2000 
folder. 

 

4. Press the Save button. Your Select Settings will be saved as an R2K file. 

 
To run an R2K again:   

• Press the Load From button on the Report tab.  

 

• When the Open Report window pops-up, select the name of the R2K you want to 
open, and press the Open button. Your R2K will open, and you can then run or 
edit it. 

 
Saving your Select Results (your answer set) 

1. When you have finished designing your report, press the Run Query button on the Results 
tab. 

 

2. When your report displays, press the Save as Table button to save your results table as a 
".db" file, or press the Save as File button to save your results table as a text file. 
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3. In the File Name field, type in the name of the report results.  

 

     
NOTE:  You can’t re-open the DB or text file in MIS2000. You can 
view it with software such as Microsoft Word or Access. 

 

Exercise 
In the Comparisons tab, create a comparison that will look at all students who have enroll dates 
between two particular dates (choose two dates) AND who attend a particular school (choose a 
school from your database). 
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Designer Overview 

 

Before learning about Desginer, you should have a good understanding of Selector, the basis of 
Designer (see page 62 for a Basic Selector Tutorial).   

 

Following is an introduction to Designer. After reading this section, we recommend that you 
work through the Designer tutorial (see page 76). Getting hands-on practice is the quickest way to 
learn Designer. 

 

To look at Designer: 

1. Go to the Reports pull-down menu and select Report Builder.  

2. The Report tab will be showing when you open Selector. Check the Advanced button. 

3. Select the Snap Setup tab and press the Designer button. 

 

What you see now is Designer. This tool is used for arranging and organizing your Selector 
report. You cannot build a report in Designer, you can only "pretty it up" here. To build a report, 
you must use Selector. 

 
Design and Preview Tabs 

There are two tabs in Designer: the Design tab and the Preview tab. 

 

On the Design tab you specify how the Selector data will be positioned on the page, how you 
want your data grouped and sorted, and how you want your text to look (bold, italicized, etc). 
When working on the Design tab, you are working with "data representations," not the data itself. 
Think of the Design tab as a "virtual report." It has the structure and instructions for creating the 
final report, but it is not the report itself.  

 

Notice that there are three sections to the Design tab. The Header section, the Detail section, and 
the Footer section. 
 

• The Header is where you put information that you want listed at the top (head) of every 
page, such as column labels and headers. 

 

• The Detail section is where you will put the bulk of your report data. 

 

• The Footer section is where you put information that you want listed at the bottom (foot) 
of each page, such as the page number or print date. 
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Here is an example of a Design Document in the Design tab. 

 

On the Preview tab you can see what your report will actually look like.  

Here is a section of the report on the Preview tab.   
 

When working in Designer, you will switch back and forth between the Design tab and the 
Report tab. After you make a change to the Design tab, you can click on the Preview tab to see 
how the change looks on the report.  
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Toolbars 

You will use the Toolbar buttons a lot when working in Designer. If you hover your mouse over a 
toolbar button, a little yellow field will appear to tell you the function of the item.  
 

Go the View menu and select Toolbars. You will see a list of all the available toolbars. We 
recommend leaving the following toolbars checked: 
 

  
  

Here are the main toolbar items you will use: 
 

 The DB Text button lets you add Selector data to your Design Document. 

  The Label button lets you put labels ("nametags") on your Design Document. 

 The DB Calc button lets you perform simple calculations such as adding. 

 The Print, Print Preview, Cut, Copy, and Paste buttons allow you to 
quickly edit and print. 

 The System Variable button allows you to add fields such as Page Number, Time, and 
Print Date. 

 The Nudge buttons allow you to move the items on Designer around. 

 New, Open, and Save allow you to create a new Designer, open an existing 
Designer report, and to save the Design Document you’re currently working on. 

 The Page Setup button brings up a window with options for changing paper 
size/orientation, paper source, margins, and layout: 
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Basic Designer Tutorial 

 

The easiest way to use this tutorial is to print it by pressing the Print button at the top of this 
window. If you haven’t yet read the Designer Overview on page 72, we recommend that you do 
so before doing this tutorial. 

 

  
NOTE: Designer allows you to format your Selector report. 

 
 

Opening your R2K and Designer Document  

The first step in using Designer is to select and organize the data you want included in your 
report. You do this with Selector. For this tutorial, we will use the report we created in the 
Intermediate Selector Tutorial.  

 

1. Open Report Builder and check the Advanced box on the Report tab. 

 

2. Open SelectorTutorial.R2K: Press the Load From button on the Report tab in Selector. 
Then select "SelectorTutorial" and press Open. Your R2K will then open. 

 

3. Once you have "SelectorTutorial.r2k" open, select the Snap Setup tab. 

 

4. Press the Build Snap Table button. In a few seconds, you will see a table open called Report 
Results. This table holds the data from your Selector report results. Designer will need to 
look at the data in this table. 

 

5. On the Report Results table, press the Close button. Then press the Snap Designer button. 

 

Now the Designer window is ready for you to work on. 

 
Inserting Database Fields 

Notice there are three bands in Designer: Header, Detail, and Footer. In the Header section you 
put data that you want to appear at the top of every page. In the Footer section you put data you 
want to appear at the bottom of every page. In the Detail section you put data you want to appear 
in the middle of each page: your report data. 
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1. To add a database field to your report, press the DB (Database) text button at the top of your 

screen . Then click your mouse in the Detail band. You will see a field with "handles" 
on it. Place the DB field to the far left of your Detail band, and at the top of the Detail band: 

 

  
 

2. Now you need to choose what data to put in this DB field.  At the top of your screen there 
are four white fields. Click on the arrow in the second field. This drop-down field contains 
all the database fields you chose in Selector. Highlight Facility Name. The name of the first 
school listed in your Selector report will appear in the DB field. 

 

  
 

3. Press the Preview tab, and you will see how you report looks so far. You should see a list 
of Facility Names all the way down the page. 

 

Now you should have a beginning understanding of how Designer works. Wherever you put the 
DB field on the Design tab is where the actual data will be listed on the report. 
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4. Let’s add the rest of our database fields. Following steps 1-2, pick up another DB text field 
and put it beside the Facility Name item. Then click in the drop-down field and select 
Grade. You will see a grade appear in your DB Text field.   

 

5. Press the Preview tab. You will now see a list of grades next to the facility names. 

 

  
NOTE: You can enlarge the size of your preview page by entering a 
percentage in the percentage field and pressing Return. You can scroll 
through the pages of the report by pressing the arrow keys. 

 

6. Add four more DB Text fields. Designate them as Last Name, First Name, Enroll Date, 
and Age (whenever you select birthdate as a field in Selector, it will automatically calculate 
the age for you.).  Select the Preview tab and you will see that all five fields are now being 
displayed on your report. 

 

  
Your Design tab should look something like this. 

 

  
NOTE: To edit a DB Text field in your Design tab, click your mouse on it. 
You will see black "handles" appear around the field. You can then go up to 
the white field and change the DB field. Whichever DB Text field has the 
handles around it is the currently selected field. 

 
Adding Labels 

Now we need to add labels to these DB fields, so the reader of the report will know what the data 
on your report is (for example, the reader may not know whether the names listed are the names 
of teachers, parents, or students). 

 

To add a label to your Design Document: 

 

1. Press the Label button: .  

2. Click your mouse in the Header tab, over the Facility DB field. A field with handles called 
"Label 1" will appear. 

3. Look in the first white field at the top of your screen, and you will see that it holds the word 
"Label 1." In this field, you type the text that you want to appear on your labels. Delete the 
words "Label 1" and type Facility Name in the field. The words "Facility Name" will be 
added to your actual label for you.  
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Your label should look like this. 

 

4. Follow steps 1-3 to add labels to the other DB fields. Name them Grade, Student Last, 
Student First, Enroll Date, and Age.  

 

Yo
ur screen should look like this. 

 
Formatting Your Design Document 

Now its time to clean up the Design Document to make our report look neat and professional!  

 
Adding a Title 

1. Go to the Report menu, and select the Title menu option. A new band will be added to your 
Design Document above the Header band. This band is called the "Title" band. 

2. Press the Label button, , and put a label in the center of the Title section. 

3. In the white label field to the top left of your screen, type in the words "Enrollment Report 
(Sorted by School and Grade)" 

4. With your Title label still selected (to select it, just click on the label field and the black 
handles will appear around it), press the Bold button and the Underline button.  
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Your title should look like this. 

 

  
NOTE: Labels in the Title band are only printed on the first page of the 
report. If you want your title to appear on every page, place the title label in 
the Header section. 

 
Enlarging DB items 

We need to enlarge the DB fields so that they will hold long words. Remember, the Design 
Document is a representation of what the actual report will look like. The DB fields will not 
expand on their own to fit the words. They will stay the exact size as they are on your Design 
Document, so we need to make them bigger. 

 

1. Select the Facility DB field by clicking on it. Hold your mouse over the right side of the 

field and you will see a resizing arrow appear: . Pull the 
Facility field to your right until it looks big enough to hold the names of most of your 
facilities. 

 

2. Expand your other DB fields, too. Use your own judgement, and make them roomy enough 
to hold your data. You will probably need to move your labels and DB fields abound a 
bit.To move a field, just click on it and drag it. 

 

 Once you have enlarged your fields, your Design Document should look something like this. 
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Resizing Bands 

Press the Preview tab and look at your report. Notice that there is a lot of space between each 
row of the report. Let’s tighten the report up so that more rows will fit on each page. 

 

1. Hold your mouse over the gray bar that says "Detail." You will see a resizing arrow. Pull the 
gray bar up until it almost touches the DB fields.  

2. Using the same procedure, pull the Title bar up to the bottom of the title.  

 

 
 

Formatting with Fonts and Styles 

Now lets format our labels so that they stand out more. 

 

1. Select the Facility Name label by clicking on it. Then press the Underline button.  

2. Click in the drop-down field of fonts and select 12. 

3. Follow steps 1-2 to make all of your labels underlined and in 12 font. 

 

 
Your labels should look like this. 

 
Using the Nudge buttons 

Chances are that some of your labels and DB fields aren’t lined up quite evenly. Using your 
Nudge buttons, you can "nudge" your fields around until they are exactly where you want them 
(if you don’t see the nudge  buttons, go to the View Menu, select Toolbars, and select Nudge). 
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You can see that these three labels are not lined up evenly. To even them up, you could select the 
”Student First" label, then press the Nudge Down button.  

  
The label will move downward. You can keep nudging the label until it is where you want it. 

 

Adding Page Numbers and Print Date 

To finish touching up our report, let's add page numbers and the print date to the Footer of our 
report. Remember, data listed in the Footer will appear at the bottom of every page. 

 

1. Click on the System Variable button  on the toolbar. Then put your mouse to the top 
left of your Footer section and click. You will see a System Variable field appear. 

2. Click in the drop-down field to the top left of your screen, and select Date. Today's date will 
appear in the system variable field. 

3. Pick up another System Variable field and put to the far right of  the footer. Then go to the 
drop-down field and select Page No.  

4. Finally, let's make a label for the print date field. Click on the Label button and put a label in 
front of the print date field. Go to the drop-down field and type in "Print Date." 

 
Your Footer should look like this 

 
Saving your Designer Layout 

Go to the File menu and press the Save As button. A Save As table will open. In the File Name 
field enter DesignerTutorial. Your report will be saved as an RTM report. It is a good idea to 
save your rtm files in the MIS2000 folder. 

 

 

Congratulations!  You have now designed a professional looking report in Designer. Press the 
Preview tab to see how your finished report looks. It should look something like this (except all 
your first names won't be the same!) 
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Intermediate Designer Tutorial: Adding One Group 

 

In order to do this tutorial you must have completed the Intermediate Selector Tutorial. 
 

In many reports you will want to create groups. You may want a report that has students grouped 
by school, test scores, days enrolled, etc. Having your data grouped can make it easier for the 
reader of the report to understand the data at a glance. Here is an example of a report with 
grouping: 

  
This report has three groups:  District Code, Test Name, and Test Level.  

 

 

Here is the Design Document for the above report: 
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Opening the Selector (R2K) file and Designer File (RTM) 

1. Open Report Builder. Press the Load From button on the Report tab and open the R2K you 
created in the Intermediate Selector Tutorial, SelectorTutorial.R2K. 

 

2. Go to the Snap Setup tab and press the Build Snap Table button. Once your table has 
opened, press the Close button.  

 

  
NOTE: We have to open the R2K file and build the Snap Table so that 
Designer will be looking at results of your Selector report. 

 

Then press the Designer (or Snap Layout) button. Go the File Menu and open the document we 
created in the Basic Designer Tutorial, DesignerTutorial.RTM.  
 

Choosing what you want to Group on 

1. Go to the Report menu and select Groups. A Groups window will open. Click on the arrow 
of the white drop-down field. You will see a list of all the report fields you choose in 
Selector.  

 

2. We want to group on Facility Name, so click on Snap.Facility Name and press the Add 
button, then press OK. You will see two new bands added to your Designer: Group 
Header:Facility Name and Group Footer:Facility Name. 

 

  
Any data you put in the Group Header band will be listed at the top 
(head) of each group. Any data you enter in the Group Footer will be 
listed at the bottom (foot) of each group. 
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Formatting your Group 

1. We want to put the Facility Name label and Facility Name DB fields in the Group Header, so 
that those fields will appear at the head (top) of each group. 

 

2. We must first make some space in the Group Header to put the label and DB field. Hold your 
mouse over the words "Group Header" and you will see a double arrow. Pull the arrow 
downward, and white space will appear between the words "header" and "group header."  

 

3. Click on the Facility Name label and drag it into the Group Header band. Then drag the 
Facility Name DB field into the Group Header band. Now these two fields will be listed at 
the top of each group on your report. Click on the Preview tab to see how your report looks 
now. 

  
Your band should look like this. 

 

4. What else might we want at the top of each group? We probably want our other labels to 
appear at the top of each group, too. Hold your mouse over the words "Group Header" again, 
and pull your arrow downward. We need to make enough space in the band for the other 
labels. 

 

5. Now drag the other labels into the Group Header band, underneath the Facility Name fields. 
Place the labels above their corresponding DB fields. Press the Preview tab to show how your 
report looks so far. 

 

  
Your Design Document should look like this. 
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6. We’re almost done! Let’s clean up the Design Document a little.  

• Select the Facility Name DB field and change its font to 12 (go to the drop-down 
field with a number in it and select 12). Keep the DB field selected, and underline it 
by pressing the underline button. 

 

• Select the Facility Name Label and place a colon after the words "Facility Name" 
(enter the colon in the Label Text field to top left of your screen). 

 

Press the Preview button, and you will see your final results. Looks good, doesn’t it? 

Your report should look something like this. 
 

Saving Your Intermediate Design Document 

Let’s save the work we just did on our Design Document: Go to the File menu and select Save 
As. Enter the name, "IntermediateDesigner" in the file name box. Press OK. You will now have 
two RTMs: "DesignerTutorial.rtm" and "IntermediateDesigner.rtm" 
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Neat Designer Trick! 

If you need to move several DB fields or labels around on your Design Document, you don’t 
have to move them one by one. You can "lasso" them and move a whole group of fields at once.  
 

Click anywhere above and to the right of the items you want to move. Drag your mouse down 
and to the left, and you will see a field of dotted lines moving with your mouse. It’s like a lasso: 

 

  

Let go of your mouse, and you will see that all the lassoed items have gray handles on them. 
You can now click on the entire group of fields and you move them all at once. 

 
Exercise 

Lasso the Grade –Age labels and practice moving them around your report. 
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 Advanced Designer Tutorial: Using Multiple Groups 

In this tutorial we will add another group, so that our report will have two groups.  

 
Opening the Selector (R2K) file and Designer File (RTM) 

1. Open Report Builder. Press the Load From button on the Report taband open the R2K you 
created in the Intermediate Selector Tutorial, SelectorTutorial.R2K. 

 

2. Go to the Snap Setup tab and press the Build Snap Table button. Once your table has 
opened, press the Close button.  

 

  
NOTE: We have to open the R2K file and build the Snap Table so that 
Designer will be looking at results of your Selector report. 

 

3.  Then press the Designer (or Snap Layout) button.  

 

4.  Go the File Menu and open the document we created in the Intermediate Designer Tutorial, 
IntermediateDesigner.RTM.  

 
Choosing what you want to Group on 

1. Go to the Report menu and select Groups. The Groups window will open. We have already 
grouped on Facility Name, so Snap.FacilityName is already showing in the Groups window.  

 

2. Press the Add button, and "FacilityName" will appear again. We need to change the bottom 
"Facility Name" group to Grade. 

 

3. Select the bottom "FacilityName" group. From the drop-down box, select Snap.Grade. You 
should now have two Groups: Facility and Grade. Press OK.  

 

  
 

4. In addition to your Facility Group header and footer, you will now see two new bands added 
to the Design tab: Group Header:Grade and Group Footer:Grade. The report will be 
grouped first on Facility. Then, within each facility group, there will be a grade group. 
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5. We want to put the Grade label and Grade DB field in the Group Header:Grade band, so 
that those fields will appear at the top of each grade group. We must first make some space in 
the Grade Header to put the label and DB field. Hold your mouse over the words "Group 
Header: Grade" and you will see a double arrow. Pull the arrow downward, and white space 
will appear. 

 

6. Click on the Grade label and drag it into the "Group Header: Grade" band. Then drag the 
Grade DB field into the "Group Header: Grade" band. Now these two fields will be listed at 
the top of each Grade Group on your report. Click on the Preview tab to see how your report 
looks now. 

 

7. Our report would look better if the other labels were in the "Group Header:Grade" band, too. 
Drag the other labels into the Group Header band, next to the Grade fields.  

 

 

Your report should look like this. 

 
Formatting your Report  

1. Use your lasso to highlight the Grade DB field and Grade label. Press the B button to 
make them bold (see "Designer Intermediate Tutorial" to learn how to use the lasso). 

 

2. Use your alignment buttons to align any fields that may be uneven. These alignment buttons 
make formatting your reports very easy (If you don’t see the Align buttons, go the the View 

menu, Toobars, and select Align or Space). :   

 

3. Lasso the uneven fields, and press the Align Bottom button  to line them up across the 

bottom. Use the Align Top button  to line them up across the top. Hover your mouse 
over the alignment buttons to learn their functions. Practice using them. 
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What is a Snap Report? 

 

A Snap Report is a report that is saved in a list so that you can run it again and again. 

 

To get to Snap Reports, go to the Reports menu and select Snap Reports. The MIS2000 Snap 
Reports window will appear. Here is an example of a Snap Reports list: 

  
 

Read the following section if you are designing your own reports:   
 

A Snap Report is a report that was created in Report 
Builder using Selector and Designer. A Snap Report is a 
combination of your Select Settings (R2K file) and your 
Design Document (RTM file).  You select your data with 
Selector, polish your report format with Designer, then 
use Snap Reports to run both files together to give you a  
professional looking report. 

 

Technically, you can run your Select and Design 
Documents from within Report Builder. But Snap 
Reports is a handy way to save your Select and Design 
Documents together in one place so that you can easily 
run the report again and again, without having to go into 
Report Builder. 
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Running Snap Reports 

 
To run a Snap Report: 

1. Highlight the name of the report you wish to run.  
 

2. With some reports you have the option to put "filters" on your report. Add filters if desired. 
 

3. Press the Run Report button. Your report will then run and display your results. 

 
Using Snap Report Filters: 

  
 

In this example: 

1. The report "Days Absent by District" was selected. 
 

2. In the "Add Your Own Filters" field there was the option of adding a filter to the field 
Facility.District Code. We decided that we wanted to see only data for District 100. So 
"Facility.DistrictCode" was selected.  

 

3. In the Comparisons list, the = was selected. 
 

4. In the top white field the value 100 was entered.  
 

5. The Add Filter button was pressed. The filter "Facility.DistrictCode" appeared in the large 
white field. Now the report will only bring up data about District Code 100. 
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6. Next, we wanted to limit our report data to data only within a certain date range. So the dates 
09/01/98 and 05/01/99 were entered in the Start Date and End Date fields. 

 

7. The Run Report button would then be pressed to view the report.  

 

This report will now be limited to data in District 100, and data between 09/01/98 and 05/01/99. 

 

  
NOTE: Not all Snap Reports require the addition of 
filters.  
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Adding Reports to the Snap Reports List 

 

It is easy to add a report to the Snap Reports List. You just have to tell MIS2000 which RTM and 
R2K files you want to use to make up the Snap Report. 

 

  
NOTE: A Snap Report is a report that was created in Report Builder using 
Selector and Designer. A Snap Report is a combination of your Select 
Settings (R2K file) and your Design Document (RTM file).  You select your 
data with Selector, polish your report format with Designer, then use Snap 
Reports to run both files together to give you a  professional looking report. 
 

Technically, you can run your Select and Design Documents from within 
Report Builder. But Snap Reports is a handy way to save your Select and 
Design Documents together in one place so that you can easily run the report 
again and again, without having to go into Report Builder. 
 

 

To Add a Report to the Snap List: 

1. Write down the names of the RTM and R2K files that will make up the Snap Report. 
 

2. Go the Procedures menu at the top of your MIS2000 screen, and select Configure Reports. 
 

3. A Configure Reports window will appear. In this table are listed all of your Snap Reports. 
Click anywhere in the Configure Reports grid and press the Insert key. A blank line will 
appear for you to enter you new report information. 

 

4. In the Report Name column, create a name for your report. This name you enter is what you 
will see in your Snap Reports List. 

 

5. In the Report File Name column, type in the name of your RTM file (example: 
"DesignerTutorial.RTM") 

 

6. In the R2K File Name  column, type in the name of your R2K file (example: "Selector 
Tutorial.R2K") 

 

  
NOTE: Giving your RTM and R2K files the same name may eliminate 
confusion about which RTMs and R2Ks go together. For instance, you could 
name files for an enrollment report "Enroll.RTM" and "Enroll.R2K" 

 

Your report will now appear in the Snap Reports List. All you have to run your Snap Report is go 
to the Reports menu, select Snap Reports, select the report in the Snap Report List, and press the 
Run Report button. 
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Advanced Snap Features 

 

Using Variable Start and End Dates 

This is an Advanced Report Builder topic, and will be best understood by people with 
experience in using Selector and in adding reports to Snap. 

 

Let’s say that you created a Snap Report that you plan to run once a month, or once a year. But 
each time you run the report you want to use a different date range. For instance, your could have 
a Snap Enrollment Report, and you want to enter different enrollment dates each time you run it. 

 

You could go into your R2K file and change the dates each time you run the report, but that 
would be time-consuming. Instead, you can design your report with variable report dates. Then 
Snap will allow you to enter your dates right on the Snap Reports window, and you’ll never have 
to go back into your R2K file to change dates. 

 

  
Here is where you enter your variable dates on the Snap Reports window. 
 

Tutorial: Adding Variable Start and End Dates to your R2K 

1. Open Report Builder 
 

2. Select All Enrollments, then go to the Comparisons tab.  
 

3. Open the School History table, and select the Enroll Date field. 
 

4. Select the between comparison. 
 

5. In the top white field, enter !startdate 
 

6. In the bottom white field, enter !enddate 
 

7. Press the Add Comparison button.  
 

If you then completed this report and loaded it into Snap Reports, your Snap Reports window 
would allow you to enter a date range each time you ran the report. See page 94 to learn how to 
load a report into Snap reports. 
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Adding Filter Fields to a Snap Report 

 

This is an Advanced Report Builder topic, and will be best understood by people with 
experience in using Selector and in adding reports to Snap. 

 

  
 

Notice that this report has two fields entered in the "Add Your Own Filters" field: 
District.DistrictCode and District.RegionCode. The person who runs this report could use either 
of these fields to limit the data shown on the report. They could limit their report to students only 
in District 100, or to students only in Region 2 (see page 92 to learn more about using Snap 
filters). 

 

Here’s how you add fields to the "Add Your Own Filters" window: 

 

1. Open Report Builder and select All Enrollments (or any Report Type). 

 

2. Press the Snap Setup tab. 

 

3. Open the table that contains the field you want to put in the "Add Your Own Filters" window.  

 

4. Highlight the field and press the Add Snap Field button. That field will appear in the large 
white field. It will be added to the "Add Your Own Filters" window in Snap, and can be used 
as a filter when the report is run. 

 

 
District.DistrictCode was added on the Snap Setup tab, and this field will now appear in the "Add 
Your Own Filters" window in Snap Reports. 
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UNDERSTANDING HELP 
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About Table of Contents Help 

Table of Contents (TOC) Help is help in book format. It is like having an MIS2000 manual right 
on your computer. In the TOC, topics are arranged into Chapters and Pages. You can browse 
through TOC Help as you would browse through a book.  
 

1. Click on the Help menu at the top of your screen, and select Contents and Index. The Help 
window will open with the TOC already open. Notice that there is an "Explorer" in the left 
panel, and in the right panel there is a yellow window where help topics are displayed. 
 

2. In the Explorer, double-click on the chapter you want to open. A list of pages will appear 
under the chapter. 
 

3. Double-click on the page you wish to view, and your help topic will appear on the right 
panel.   

 

  
Help Explorer      The Help topic you selected is displayed here 
 

4. To look at another topic, simply double-click on the topic in the Explorer panel. It will then 
appear in the panel to your right. 
 

5. Familiarize yourself with these buttons on the Help window: 

 

 

To go back to the last Help topic you looked at, click on Back. 

To print the Help topic, press the Print button. 

Use the Browse buttons to move back and forth between topics in the selected chapter. 
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About Index Help 

Your online manual has an index similar to an index in the back of a book.  
 

1. Click on the Help menu at the top of your screen, and select Contents and Index.  
 

2. When the Help window pops-up, select the Index tab. 
 

3. Type in the first few letters of the topic you’re looking for, and the index will shift 
accordingly. 
 

4. You can browse through the Index by clicking on the up and down arrows on the right side  
of the Index. 
 

5. Select the topic you want to view. The Help topic will open, and you will see a screen 
similar to this: 

 

  

In this example, the word "student" was typed in the white field. The index shifted to the word 
"student" in the index. The topic "Student: difference between Student Data and a Student 
Record" was selected, and that topic popped-up in the yellow field. 
 

Familiarize yourself with these buttons on the Help window: 
 

  
 

To go back to the last Help topic you looked at, click on Back. 

To print the Help topic, press the Print button. 

Use the Browse arrow buttons to move back and forth between topics in the selected chapter. 
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About Search Help 

If you want to search the online manual for a particular word or phrase, you can do that with 
Search Help. Search Help will scan all the Help topics and give you a list of the topics that 
contain your selected word(s). 
 

1. Click on the Help menu at the top of your screen, and select Contents and Index. 
 

2. When the Help window pops-up, select the Search tab. Press the Next, and then the Finish 
button. The Search Help window will open. 
 

3. Follow the 3 steps listed in the Search window to find the topics associated with your 
word(s).  

 

  

In this example, the words "print," "student," and "record" were typed in the field. Search Help 
scanned all the topics and came up with four topics that contain all three of those words. The 
topic, "How do I print a Student Record" was selected, and that topic popped-up in the yellow 
field. 
 

 

Familiarize yourself with these buttons on the Help window: 

  
 

To go back to the last Help topic you looked at, click on Back. 

To print the Help topic, press the Print button. 

Use the Browse arrow buttons to move back and forth between topics in the selected chapter. 
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CONTACTING MS/EDD 
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Feedback on the MIS2000 Manual 

 

We want our manual to be comprehensive and easy to understand. Is there anything we forgot to 
add to the manual? Do you have any suggestions that would make the manual more helpful to 
other users? 

 

If you have any suggestions or comments about the MIS2000 manual, please contact Emily 
Pennel at support@msedd.com or at (501) 801-2500. 
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MIS2000 Technical Support 

At MS/EdD, we are working hard to provide you with software that is user-friendly. Additionally, 
we try to provide superior on-line help to provide you with the answers you need. To familiarize 
yourself with how MIS2000’s Help system works, read through the chapter called "Understanding 
Help."   

 

If you cannot find the answer you need in MIS2000’s manual, please contact us. MS/EdD’s staff 
is happy to help you with any questions or problems you have regarding MIS2000. 

 

Telephone Support 

You can reach us by phone at (501) 801-2500. Our Office Hours are Monday-Friday, 8:00 a.m.-
5:30 p.m., Central Time. 

 

E-Mail Your Questions 

You can e-mail us with your questions. Email: support@msedd.com. 
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Management Services for Education Data (MS/EdD) 
Headquarters 

 

Management Services for Education Data (MS/EdD), the company that produces MIS2000, is the 
leading provider of software and computer services for migrant educators. 

  

Address:   Management Services for Education Data 

    7540 Highway 107 

    Sherwood, Arkansas 72120 

 

Telephone:  (501) 801-2500 

 

Fax:   (214) 853-5177 

 

E-Mail:  Support@msedd.com 

 

World Wide Web: www.msedd.com  

 

Office Hours:  Monday-Friday 

    8:00 a.m. to 5:00 p.m.  Central Time 
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